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Overview  

Pathport Manager 5 is a software program used to configure, troubleshoot and monitor 
Pathport® DMX-over-Ethernet nodes manufactured by Pathway Connectivity.  Pathport 
nodes are used primarily in entertainment and architectural lighting systems employing 
DMX512 as the control protocol. 
 
Pathport Manager 5 will configure properties for all Pathport one-port, two-port, four-port 
and eight-port nodes using a firmware version of 3.0.2.x or higher.  Pathport Manager 5 
will retrieve and set channel patches, and perform firmware upgrades on all nodes using 
firmware of 3.0.4.x or higher.  Earlier firmware versions require Pathport Manager 3. 
 
Pathport Manager 5 is a Java application, requiring Java 1.6 or greater, and will run on 
Windows XP and Vista, Mac OS 10.5 on Intel Duo Core machines, and Linux. 
 
Philosophy 
Pathport Manager 5 provides the user with two different views of a Pathport system.  
The Nodes Properties screen shows individual nodes and their ports – good for global 
configuration – while the DMX Patch provides a port-based view, for patching control of 
the DMX flow.   
 
Because reconfiguration of a Pathport system is typically not done very frequently, 
safeguards are in place to prevent accidental changes.  Also, several diagnostics have 
been included to help sort out networking problems and to assist in troubleshooting. 
 
PM5 is designed around the separation of the editing process from the application, or 
commiting, of the new values.  Changes are queued until the user chooses the ‘send 
changes’ button, to reduce the chances of accidentally making unwanted changes.  
Likewise, configuration, patching and firmware each have their own commit button, so 
only the changes currently visible (highlighted in yellow) are ever sent.   
 
As a further guard against accidental changes, Pathport Manager 5 now includes an 
auto-backup feature, with a history of ten commits.   
 
As well as improved versions of the Virtual Console and the xDMX Monitor, Pathport 
Manager 5 now provides information on the user’s Network Interface Card (NIC), the 
ability to view non-DMX packet traffic between the computer and a selected node, an 
event log, user-defined views of node properties, and showfile saving and restoring in a 
off-line editable CSV format. 
 
Changes from Previous Versions 
Pathport Manager 5 completely supersedes version 4 of the software.  Version 3 is still 
required to upgrade nodes from 3.0.2.x firmware, to reach full functional compatibility 
with this release. 
 
Quick Universe patches are now deprecated.  Patching done with PM5 is of Source 
Universes only, a more comprehensive and flexible format.  Quick universe support is 
still available, but is not recommended for new patches or systems.   
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Installation, NIC Configuration and Start Up 
Pathport Manager 5 runs on Windows, Mac or Linux operating systems using Java 1.6 
or higher.  Go to java.com to verify your version is up-to-date. Mac users must be using 
64-bit processors and must set Java SE 6 (64-bit) as the default engine.   
 
Because Pathport Manager must often be downloaded using slow or poor connections, it 
is not a self-installing program with embedded Java engine, in order to reduce file size. 
 
Unzip Pathport Manager 5 into a directory of your choice.   Click on the filename 
‘PathportManager5.jar’ to launch the program.  The ‘run.bat’ and ‘run.sh’ files can be 
used by Windows and Linux users respectively to launch Pathport Manager with 
memory optimization and command window logging. 
 
Before launching PM5, the computer’s network interface card (NIC) must be set to the 
same IP domain and subnet mask as the Pathport nodes, or the nodes will be shown as 
‘questionable (can’t fetch props, can’t fetch patch)’.  The default settings for Pathport 
nodes are in the 10.x.x.x IP range with subnet mask of 255.0.0.0.   

Log-in Screen 
A splash screen appears upon launch.  Any errors encountering during start up are 
reported in the Event Log. 
 
The first time Pathport Manager 5 is run, the user will be prompted to create an 
administrator account.  Fill in a name and password and click OK. 
 

 
 
Once an account is created, the password must be provided when PM5 starts, or the 
program will only run in Monitor mode. 
 
The Administrator account is not intended as strong security, but to separate 
configuration functions from monitoring functions.  Although PM5 encrypts the user 
name and password, this information is not stored by the Pathport nodes, so the admin 
name and password only apply to the current software installation. 
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Node Discovery  
Connected nodes are discovered automatically as soon as PM5 starts up. Nodes appear 
in the upper portion of the start up screen, the Device List, sorted by ‘Current Name’, or 
whatever column was last used to sort devices. 
 
The first time Pathport Manager 5 is run on an exis ting installation, we strongly 
recommend you save a Showfile from the “File > Save  As…” menu before 
attempting any editing.   
 

 
 
At the bottom of the screen, an indicator bar reports the number of nodes and their 
status.  This indicator bar is visible in all screens and is updated continuously. 
 
Online status is reported separately from communication status.  If a node is reported as 
“online” but its status is “questionable”, the most common reason is an IP address and/or 
subnet mask incompatibility between the node and the computer running PM5.  PM5 will 
report a node online even if communication to the node is unreliable or unavailable.   
 
Check addressing compatibility using the Network Interfaces button or see 
Troubleshooting  for tips on resolving the issue. 
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Displaying Node and Port Properties 
Click on a node in the Device List and its base properties appear in the lower Device 
Properties pane, along with tabs for each of its ports. 
 

 
 
Both the Device List and Properties are easily up/down sorted by clicking on column 
headers.   
 
Enter text in the Filter box to display only those nodes with properties that fully or 
partially match the text.   
 
More than one node can be selected in the Device List, using the Ctrl or Shift keys.   
 
Properties common to the selected nodes will be displayed under Device Properties, 
allowing global editing. 
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Editing Base Node Properties 
The first time Pathport Manager 5 is run on an exis ting installation, we strongly 
recommend you save a Showfile from the “File > Save  As…” menu before 
attempting any editing.  When using nodes with firmware of 3.0.2.x or lower, the patch 
settings will not be retrieved or saved. 
 
Properties are edited in the lower Device Properties pane.  The property’s current value 
is shown under the Current Value column.  Changes are made under the New Value 
column.   When a new value is entered, the cell background changes to yellow.  Multiple 
changes can be made prior to updating the node.  Only cells with a white background 
can be edited.  Grayed-out values cannot be changed.   
 
‘Send Config to Nodes’ sends all queued changes to the selected node (or nodes) and is 
the only way to update nodes – PM5 does not make any changes on the fly.  A 
transaction window will appear: 
 

 
 
Once the new properties are sent, PM5 confirms that the node received them.  A 
common reason for a transaction to fail is because the node’s firmware does not support 
a given property.  Any property listed as [null] is not supported by the node. 
 
‘Discard Changes’ clears all unsent changes.  This is not the same as an Undo button.  
See Auto Backup and Restore, if changes need to be undone. 

Global Editing 
Use standard Shift-click and CTRL-click methods to select multiple nodes.  Only 
properties common to all nodes selected will be shown.  The Filter search box can then 
be used to further narrow down the fields shown.  Where the ‘Current Value’ for a 
property differs among the selected nodes, the value is shown as ‘diverse’.  
 
CAUTION:  Global changes to certain properties are unwise.  Specifically, changing 
multiple nodes to the same IP address will cripple your system.  
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Editing Port Properties 
Port properties are edited using the same conventions as node properties.  Property 
definitions are given in Appendix B.  Not all properties are shown by default.   
 

 
 
Port properties for multiple nodes may be edited simultaneously.  For example, to 
change all nodes to use a DMX output speed of Fast, select all nodes in the Device List 
(either shift-right click, or control-A), choose the Ports tab in the Device Properties list, 
then select Fast from the drop-down menu next to DMX Output Speed. 
 
Queued changes to port properties are highlighted in yellow.   The highlighting will clear 
once the “Send Config to Nodes” button is clicked, and after the change is confirmed in 
the Transaction Monitor. The action is also noted in the Latest Action column. 
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Setting a Basic DMX Patch 
The DMX Patch tab shows a listing of input and output ports.   Each port on a node has 
its own listing.  Use the filter search to find ports on a specific node. 
 

 

Input Patch Assignment 
Input ports receive DMX from lighting boards, architectural controllers and other DMX 
sources.  Although the same universe number can be used by different input ports, it’s 
better practice to assign a different universe to each input.   
 
To change the Current Universe, click on the drop down arrow in the New Univ box: 
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Simply select the new patch from the list to assign it to the port.  Patches that are not 
being used by a port are shown with the tag “(no input)”.  Choosing “Disable” will clear 
the check box under DMX Enable, and the port will ignore any DMX it receives. 
 
Input ports are always assigned a standard universe for the patch.  Custom patching is 
always done at the output port. 
 
Once the input patch assignments are queued, click on “Send Patches to Ports” to 
update the nodes.  A Transaction Monitor window will open, showing the update 
progress.  If some of the patch updates fail, try resending the patch.  It’s possible when 
sending a large number of updates for the TFTP patch mechanism to time out.  If a 
second attempt also fails, review the Troubleshooting  section. 

Basic Output Patch Assignment 
Output ports transmit DMX to end devices such as dimmers, moving lights, and other 
receivers.  Output ports can be assigned standard universe patches or custom patches, 
in the same way as input patches are assigned. 
 

 
 
Select from the standard universe patch list.  Patches without an input are shown with 
the tag “(no input)”.  “Unpatched” clears all patch information for that port and clears the 
check mark under DMX Enable, effectively disabling the port.   
 
The list also shows custom patches (A+B+C in the example above).  Custom patches 
are created in the Universe Editor, as described in Advanced Configuration . 
 
Once the output patch assignments are queued, click on “Send Patches to Ports” to 
update the nodes.  A Transaction Monitor window will open, showing the update 
progress.  If some of the patch updates fail, try resending the patch. It’s possible when 
sending a large number of updates for the TFTP patch mechanism to time out.   If a 
second attempt also fails, review the Troubleshooting  section. 
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Showfiles 
PM5 will save and restore showfiles containing all or some of the configuration and 
patch information used by the connected nodes.  If all nodes are selected, then all 
custom patches, including ones not assigned to a node, will also be saved.  This method 
allows the user to build up a library of patches for future use. 
 
Showfile names are not saved by the nodes, only the configuration and patch 
information.  Without care, multiple shows may be created that are identical except for 
their assigned names.  Showfiles are in CSV format and can be edited off-line using a 
spreadsheet program such as MS Excel. 

Saving Showfiles 
From the File menu, select “Save As…”  If you have one or more nodes already 
selected, you’ll be asked to choose how many nodes to include in the showfile.   
 

 
 
A standard dialog box will open.  Name the showfile, or choose a filename from the list 
of recorded shows (if any), then choose Save Show.  A transaction window will open. 
 

 
 



Pathway Connectivity 
Pathport Manager 5 v1 Manual 

12 

A non-critical warning will be reported when saving shows that include nodes running 
older firmware.  In the case above, the nodes at 10.0.0.21 and10.0.0.100 both lack two 
properties, so PM5 has ignored them.  Since both the base node and each individual 
port may be lacking properties, this list can be quite long when saving from nodes using 
older firmware. 
 
Showfiles are stored in the /showfiles subdirectory of Pathport Manager 5. 
 
The showfile name is given on the title bar of the program, initially shown as “(no show)”. 
Once a show is saved or loaded, the name changes to the last showfile name used: 
 

 
 

Restoring Showfiles 
From the File menu, select Load Show…  Choose from the available files and click on 
Load Show.  A transaction window will open: 
 

 
 
In keeping with the philosophy of separating editing from applying changes, once a show 
is loaded, the user must still actually send the changes to the node.  The buttons here 
allow the configuration and patching to be sent from this window, or the changes can be 
further reviewed and edited if desired.   
 
Configuration and patches are sent separately because they utilize different methods. 
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Off-line Showfile Editing 
Showfiles are saved in a CSV (comma-separated value) format, and may be edited in 
most spreadsheet programs.  Patches as well as node parameter values may be 
changed.   
 
The format is fairly basic, but it is possible to break the showfile.  Pathport Manager 5 
will recover as much information as possible.  

Auto Backup and Restore 
Pathport Manager 5 provides a background autosave feature.  When ever any commit 
(including firmware upgrade) is attempted, PM5 will first write a full backup showfile to 
the /autobackup subdirectory.   
 
A total of ten backups are maintained, using time stamps as filenames. 
 
To restore an autobackup file, choose File > Restore Backup Show and select the 
required file by its time stamp. 
 

 
 
 
As with loading any show, the user must separately commit the configuration and patch 
changes. 
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Firmware Upgrades 

 
 
To upgrade a node, highlight it in the Upgradable Devices List.  Choose “Select 
Firmware” to manually choose from a list, or choose “Select Latest” for PM5 to 
automatically queue the latest version available. 
 
If more than one node is highlighted, only the “Select Latest” button will be available.   
 
Click on “Send Firmwares” to commit the new firmware to the nodes.  A transaction 
window will open, providing progress updates on the upgrades. 
 
The upgrade process will take between 20 and 30 seconds per node.  During the 
upgrade, the node will be reported as ‘Questionable’, then ‘Offline’.  This is normal .  
Once the upgrade is complete, the node will return to ‘Online’ and status “OK”.   
 
On larger installations, it’s possible for the TFTP transaction to time out on a few nodes.  
If this happens, retry the upgrade after selecting only those nodes.   
 
Pathport Manager 5 performs a check prior to sending firmware, to prevent a node from 
receiving an incompatible file. 

Adding New Firmware Files 
Firmware files are kept in the /firmwares subdirectory of Pathport Manager 5.  Simply 
copy new firmware files, obtained from the Pathway Connectivity website, into this 
directory.  It is not necessary to change the filename.  If it is a valid firmware file, PM5 
will make it available for use.    
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Advanced Configuration 
Pathport Manager 5 provides access to a number of advanced features including custom 
patching with merge and priority support, DMX-over-Ethernet protocol selection, signal 
loss behavior, DMX output speed and more.   
 
The most commonly used advanced feature is custom patching. 
 

Universe Editor 
DMX limits the number of output devices to 512, which means no DMX receiving device 
may have an address higher than 512.  To get around this limitation, the notion of 
universes was created, so that channel 513 (to a human) is simply channel 1 in Universe 
2 (and address 1 to the receiver, which doesn’t care about the universe number).  
 
Consoles capable of outputting multiple universes are now common.  However, it’s 
sometimes necessary for a Pathport to output DMX to devices that the console treats as 
being in different universes.  Another common problem is a requirement for two different 
consoles to control the same device at different times – or for one console to 
automatically back up another – something the DMX protocol does not seamlessly allow. 
 
User-created custom universes can resolve these problems.  Pathport output patching 
allows for each channel in the custom DMX universe to be selected and/or merged from 
up to eight different DMX input streams.   
 

 
 
Custom patches are created in the Universe Editor, then applied to output ports from the 
DMX Patch screen.  It is always good practice to start by naming the patch.  Custom 
universes may be built up from existing patches, entered from the command line, or by 
directly editing cells within the patch. 
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Building from Existing Patches 
Editing a Standard Universe will cause the automatic creation of a custom patch. 
 
Click “New” and enter a name for the custom patch beside “Universe Name”.  Click on 
either “HTP Merge” or “Priority” and select a standard universe patch from the pop-up 
list.  If any Custom patches already exist, they will be shown at the top of the list, and 
can also be selected.   
 
If you wish to merge another standard universe (or source), click the “HTP Merge” button 
and select the second source patch from the pop-up list.  Merged sources are entered 
into the spreadsheet at the same priority level as the channels immediately to the left.   
 
If you wish instead to add another standard universe as a back up source, click the 
“Priority” button and choose from the list.  Channels entered this way will be given the 
next lower priority level than the ones to the immediate left.   
 
Merge and Priority can be used in any combination or order to create a customized 
output universe based on up to eight source patches.   
 
Click on “Save Custom” to add the new custom universe to the universe lists. 

Command Line Syntax 
The basic syntax is [Output Range] {at} [Input Range Start Channel].  For example, to 
create a simple 1-to-1 patch for Universe 1, enter: 
 

1-512*1.1- 
 
The final dash is required, but there is no need to enter the final channel number.  PM5 
will do that calculation. 
 
The input channel can be entered in either “dotted notation”, where the number before 
the dot is the universe and the number after the dot is the channel, or simply a numeric 
value between 1 and 65536 (65536 = 128.512).  The “Dotted Notation” checkbox allows 
quick flipping between the two numbering systems on the fly, although either method 
may be used at any time. 
 
The command line makes it easy to write partial universe patches.  Sometimes it’s 
desirable to only control a portion of a dimmer rack, or to compensate for out-of-order 
channel assignments.  Merge and priority of multiple ranges is easily and quickly entered 
using the command line. 
 
The + sign is used to create merges.  To merge input universe 1, 2 and 3: 
 

1-512*1.1-+2.1-+3.1- 
 
Remember, the ending dash is necessary to indicate a range.  The result will look like 
this: 
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To prioritize inputs, use the / symbol (the division slash).  Inputs listed first (i.e. further 
left on the command line) are given higher priority.  To prioritize universe 3 over universe 
2 over universe 1 (again, note the final dash to indicate a range): 
 
 1-512*3.1-/2.1-/1.1- 
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A comma may be used to delimit between a series of channel ranges.  To have the first 
five channels use universe 1, and the second five use the last five channel of universe 3: 
 
 1-5*1.1-,11-10*3.508- 
 

 
 
The comma, slash and plus sign can be used in conjunction with one another.  By 
starting the command line with + or /, it is possible to add to patch, as in this example, 
building on the patch above: 
 
 +1-10*5.100-/25.200- 
 

 
 
As a further aid, the command line will shade red until a valid command has been 
completely entered.  A properly parsed command will turn the shading green.   
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Directly Editing a Patch 
Channel and priority values can also be directly entered into the spreadsheet by clicking 
on a cell and typing in the number.  Priority cells will only accept values between 1 (high) 
and 8 (low). 
 
Ranges may be entered by typing in the start value, then selecting a range of cells 
below.  An entire column may be selected by clicking on the header.  Then use the right 
click menu and choose “Fill Channel and Priority” to repeat that value through the cell 
range, or choose “Fill Channel Gradient and Priority” to increment the channel value 
through the cell range.  The priority level will remain the same in either case. 

Assigning Custom Patches to Ports 
Once the required custom patches have been created, they are assigned to output ports 
from the DMX Patch screen, in the same way as standard universe patches.  
 

 
 
Click on the drop-down arrow under New Univ.  The custom universes will now be listed 
ahead of the standard ones.  Select and commit using “Send Patches to Ports”. 

Exporting/Importing Custom Patches 
It is possible to develop an extensive library of custom patches.  However, this library is 
not stored in the nodes.  A node only knows its current input and output patches.  Any 
custom patch not in current use will be lost when PM5 is exited unless a full showfile is 
saved or the patch is exported to CSV format.   
 
Custom patches may be saved, after they’ve been written, by using the Universe drop-
down menu, or by right-clicking, and choosing Export to CSV.  A standard dialog box will 
open, asking for a filename.  Patch files are saved in the /universes subdirectory. 
 
It is possible to review universe usage statistics, as well as save and delete custom 
patch files, from within Pathport Manager 5.  From the Universe Editor screen, click on 
the right-pointing arrow (located on the upper left-hand side of the screen). 
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This will expand a hidden sidebar called Universe Statistics.  (Clicking the left-pointing 
arrow will hide it again.) 
 

 
 
 
The upper window shows how many inputs and outputs are using a specific standard 
universe patch.  The lower window shows the current custom universes, the number of 
outputs using a specific patch, and whether it is equivalent to a standard patch. 
 
Selecting a custom universe will cause its channel information to be shown on the right.  
The universe can then be saved, edited or deleted using the “Delete” button.  This button 
does not delete saved CSV files. 
 
A saved custom patch can be retrieved into Pathport Manager from the Universe drop-
down menu or by right-clicking and choosing “Import from CSV”.  A standard dialog box 
will open, allowing selection from any previously saved files. 
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Advanced Node Properties 
A full list of node properties is found in the appendix, but some require a more detailed 
description and explanation. 

Alternate ArtNet Mapping 
ArtNet universe selection is based on two 16-step rotary switches.  One switch sets the 
subnet, while the other sets the universe, so that valid universe numbers range from 0-0 
to F-F.  This arrangement does not readily translate to the linear, decimal-based 
numbering used by Pathports. 
 
The common problem is with ArtNet universe 0-0.  Traditionally, Pathports have ignored 
this universe altogether, as Pathports do not have a universe zero.  However, some 
console manufacturers present ArtNet 0-0 to the user as Universe 1, while others have 
taken the same approach as Pathway, and presented universe 0-1 to the user as 
Universe 1.  This ‘off-by-one’ problem has caused problems both with ‘disappearing 
data’ from a given console and with unexpected merges. 
 
The alternate ArtNet mapping property allows the user to choose between ignoring 
ArtNet 0-0 as universe 1 (property is disabled/unchecked – default), or to present it as 
Universe 1 (property enabled/checked off).   

E1.31 Version Selection 
The first implementations of E1.31 streaming ACN to reach the market used the final 
draft of the protocol.  During final review, some minor changes were made to the packet 
header, and this is the version that was accepted as ANSI standard.  Unfortunately, the 
changes mean the final draft and the official standard versions cannot communicate with 
one another. 
 
Without some specialized software and a packet dissector, it’s not easy for an end user 
to be certain which version of sACN is being used by a given piece of equipment.  
Pathports address this problem in two ways.   
 
First, all output ports using current firmware listen for both flavors of the protocol, without 
any user action required.  If both flavors happen to be active on the network, the 
Pathport will merge them together. 
 
Second, all input ports, which transmit onto the Ethernet backbone, can be switched 
between prerelease Draft 20, and the ANSI Final.  If one doesn’t work, try the other. 

sACN Input Priority 
E1.31 streaming ACN includes an input priority scheme that will be familiar to ETC Net2 
users.  Up to 200 levels of input priority are available (see Port Properties for setting 
actual priority levels), but the use of input priority does cause all other protocols to be 
ignored. 
 
It’s possible – but not advisable – to apply both input priority schemes and output priority 
and merge schemes to the same port.  Exactly how these different schemes will interact 
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is very difficult to conceptualize, and will likely lead to unexpected results and a 
headache. 
 
We feel the best solution is to choose one priority scheme or the other.  If sACN Input 
Priority is disabled (default), all priority and channel patching should be done at the 
output port.   
 
If sACN Input Priority is enabled, we strongly recommend patching all input and all 
outputs to universe 1, and managing all priorities through the port property “E1.31 sACN 
Input Priority Level”.   
 

Advanced Port Properties 
A complete list of port properties is given in the appendix, but some require more 
detailed description and explanation. 

Quick Patch Enable 
Pathport firmware has long supported two methods of applying channel patches: source 
patching and quick patches.  The main difference is that quick patches use blocks of 512 
channels, while source patching allows individual channels to be selected.  There is no 
longer any technical reason to use quick patches, so they are being phased out. 
 
With the full release of Pathport Manager 5 and the 3.2.x.x firmware series, quick patch 
is now officially deprecated.  The Touring Edition and Octo node do not support quick 
patch at all.  Other nodes may contain legacy configurations using quick patch, so it is 
still supported in a downgraded manner. 
 
Once a system has been upgraded to the 3.2.x.x firmware, we recommend reviewing the 
Quick Patch Enable flag in the Port Properties.  If it is checked off (enabled), make note 
of the Quick Patch Universe number for that port.  This number is directly equivalent to 
the ”Univ # “ applied from the “DMX Patch” screen.   
 
Once the patch has been upgraded to source universe  patching (from the DMX 
Patch screen), we strongly recommend de-selecting t he Quick Patch Enable box 
for all ports.  
 
If quick patch is enabled, and the Quick Patch Universe number is different from the 
Univ # reported in the DMX Patch, the system will not work as expected. 

sACN Input Priority Level 
This value only applies if “sACN Input Priority” property of the outputting node is 
‘Enabled’.  Input priority can be difficult to conceptualize, because the choices are made 
at the input port, but the effects occur at the output port.   
 
To use sACN input priority, we recommend setting all inputs and outputs to Universe 1 
(or to group all inputs and outputs into the same universes according to desired routing) 
and manipulate the active signal solely through this priority level value.  Combining input 
priority and output priority/merging may be extremely difficult to troubleshoot, and be 
difficult to reconstruct without very detailed documentation. 
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Valid priority levels range from 1 to 200, with 200 being the highest priority.  Default 
value is 100.   The value is set at the input port only.  Two sources set to the same 
priority level will be merged together.  When sACN is active with priority enabled, all 
other protocols are ignored. 
 
Input priority is a component of the E1.31 streaming ACN standard. 

sACN Input Priority Channel (Magic Channel) 
This value only applies if the “sACN Input Priority” property of the outputting node is 
‘Enabled’.  Input priority can be difficult to conceptualize, because the choices are made 
at the input port, but the effects occur at the output port.   
 
Input priority channel, or magic channel switching, allows the user to switch between 
sources of streaming ACN on the fly by changing the level of a specific DMX channel. 
 
The magic channel is specified at the input port.   The setting at the output port has no 
effect on this feature.  Any channel between 1 and 512 may be used.   Whichever input 
has the highest DMX value for the magic channel will be given priority.  If two inputs 
have the same value, they will be merged.   Values are between 0 and 255, although 
percentage will also work. 
 
Magic channel switching is a feature unique to Pathports. 

Crossfade between Inputs 
This feature allows for seamless hand-off between consoles.  In some installations, a 
background or architectural controller runs the lights the majority of the time.  But at 
certain times, a show controller must take over the rig.  Crossfade allows this transfer of 
control to occur without the lights blinking or jumping.   
 
This feature is set port-by-port at the output.  Crossfade Enable must be checked, and a 
crossfade time entered.  Crossfade times are in milliseconds and range from 0 to  
172800000 (two days). 
 
Crossfade applies whenever a port shifts from a higher priority stream to a lower one, or 
vice versa.  Signal Loss behavior still applies when a higher priority stream is lost. 

Signal Loss Behavior 
The DMX512 standard specifies that a device must maintain its last look for one second 
after the loss of valid DMX signal.  It does not specify what should happen after that 
point.  Pathports allow the user significant choice how to handle loss of signal. 
 
This behavior is set on a port-by-port basis.   A port may hold last look for a period of 
time (or forever), and then it may fade out or not.   
 
Signal Loss Hold Time sets, in milliseconds, how long the last look is held.  Once that 
time has elapsed, Signal Loss Fade behavior is invoked. 
 
Signal Loss Hold Forever, when enabled, will hold last look until the port is manually 
powered down or DMX is restored. Not recommended when connected to dimmers.  
This value overrides the Signal Loss Hold Time. 
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Signal Loss Fade, when enabled, causes the port to use the Signal Loss Fade Time 
value (in milliseconds) to fade all channels to zero.  If Signal Loss Fade is disabled, all 
channels will instantly drop to zero once the Signal Loss Hold Time has elapsed.  Signal 
Loss Fade should not be enabled on ports feeding moving lights. 
 
Signal Loss Port Shutdown, when enabled, shuts off the port once other signal loss 
behaviors are complete, so no DMX data will be sent at all until inputs are restored. 
 

Customizing Display Views 
All screens in Pathport Manager can be customized by the user.  Customization includes 
up/down sorting of columns by clicking on the column header, rearranging columns by 
dragging the header cells to new positions, changing their width, and even selecting 
which columns to display.  
 
PM5 remembers these changes.  When you restart the program, you will have the same 
display settings as when it was closed.  The results of many of these customizations can 
also be saved and recalled at another time. 
 
The name of the current display is shown on the Display button in the lower right-hand 
corner.  Clicking on the Display button brings up this window: 
 

 
 
Choosing the New button allows the current view settings to be saved to the 
/perspectives/user subdirectory.   The file can be manually moved to the 
/perspectives/default subdirectory, making it read-only.   
 
Advanced users can set up a number of specific looks tailored to specific task.  In all 
tabs and pop-up windows, a right-click menu option is available called “Select Columns 
to Display”, except in Device Properties, where it is called “Select Properties to Display”.   
 
Choosing this option will bring up a window showing all possible information columns 
associated with that particular window.  A description of the major properties is given in 
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the appendix.  Here is a portion of the column lists for the Device List and for the Output 
Port portion of the DMX Patch.   
 

  
 
By selecting or deselecting the “Visible?” checkbox, highly customized views can be 
created.  Pathport Manager notes these changes on the fly, and records them into the 
current view.  Specialized views should be saved individually as soon as they’ve been 
created.  There is no limit to the number of views a user may make. 
 

Filter Searches  
At the bottom of most windows and pop-up boxes is a filter search box.  Typing in a text 
or number string and it is applied as a filter to the window above.  The rows shown are 
limited to the ones containing the string.  This feature is extremely useful when 
managing large groups of nodes.   The filter retains the last five search strings. 
 

Error Log 
Pathport Manager 5 maintains a log of warning and error messages.  The initial start up 
messages, concerning network interfaces and file paths, may be of interest to some 
advanced users.   
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Troubleshooting  

Network Interfaces – Online yet Questionable 
The most common problem when using a Pathport system is an IP addressing 
mismatch.  If a node is shown as being “Online” but its status is “Questionable”, the 
problem is almost always due to a mismatch between the computer’s IP (and subnet 
mask) and the IP and subnet mask used by the node. 
 
To determine what IP and subnet mask is used by your computer, click on the “Network 
Interfaces” button in the lower right-hand corner.   
 

 
 
The information is from your computer.  Check that the IP addresses are what you 
expect them to be, and make note of the subnet masks.  If no nodes are being 
discovered, make sure all available interfaces are enabled. 
 
Your computer and the node must have an IP address in the same range, such as 
192.168.1.x, where x is a number between 1 and 254, as long as x is not the same for 
both.  No two devices on an Ethernet network can use the same IP address at the same 
time.  On the other hand, your computer and the node must use the exact same subnet 
mask.  The typical subnet mask for the 192.168.1.x range is 255.255.255.0.   
 
Pathports’ default IP arrangement uses a wider range.  Pathports are shipped with an IP 
of 10.x.x.x and a subnet mask of 255.0.0.0.   

Old Firmware – Patch Failure and Unsupported Proper ties 
If the network settings seem to be correct, but patching fails, PM5 will show a GET error 
in the Latest Action column.  Check the firmware version.  Nodes with a firmware version 
of 3.0.2.x or lower cannot be patched with Pathport Manager 5.  Use Pathport Manager 
3 to upgrade the nodes to a minimum firmware version of 3.0.4.x.  
 
When saving or committing changes to Pathports running older firmware, an error 
message may be displayed saying that “x number of properties are not supported in 
firmware and were not saved”.  This message occurs when a feature, such as 
crossfading, is not supported by the older firmware.  Other than lacking some firmware 
features, the node is not malfunctioning. 
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Virtual Console – Output Testing 
Pathport Manager 5 provides, from the Tools menu, a basic xDMX signal generator to 
aid in system set up and trouble-shooting.  The Virtual Console only generates Pathport 
Protocol, so output nodes must be set to receive Pathport Protocol.  Nodes can listen for 
several protocols at the same time without compromising performance. 
 

 
 
An input universe number, between 1 and 128, is specified next to Pathport xDMX Univ.  
A start channel, between 1 and 501, is set in the Start Channel box for the twelve faders.  
An exact value between 0 and 255 can be entered below the channel number, or as a 
percentage in the percentage value box.   The faders can be moved up and down using 
a mouse. 
 
On the right is a visual representation of the active channels.  Below the map is a recap 
of the number of packets sent in this universe, which universe is the active source, and 
how many of the available NICs are being used to send packets. 
 
When first started, the input universe will immediately go active, sending a default level 
of zero on the selected channel range.  The Stop&Release button ends all xDMX 
transmission and tells output ports to begin loss of DMX behavior.  Some basic effects 
are also provided for testing purposes.  Do NOT use these effects on outputs connected 
to moving lights. 
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xDMX Monitor – Input Reporting 
As well as a signal generator, a monitoring screen is also available from the Tools menu.  
Like the Console, the Monitor only shows Pathport Protocol level information. 
 

 
 
Universes with an active input are shown highlighted in the lower part of the screen, and 
have a flashing icon.  Clicking on an active button will highlight the sources currently 
using that universe. 
 
To review specific levels, select an input from the list of Source xDMX Devices.  If the 
source is from a Pathport, acting as an input, it will be identified by name in the list.  
However, if the input is from an “Ethernet-aware” console, the source will only be 
identified by IP address.   
 
The input chart shows levels channel by channel, as a decimal value between 0 and 
255.  If the window is minimized, the input chart will display cells, like the map used by 
the Virtual Console. 
 
To check levels of other protocols, loop a DMX output back into an input port that has 
been set to transmit Pathport Protocol. 
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Display Node Communications 
Before choosing ‘Display Node Communications’ either from the TestTools menu or the 
Nodes menu, a node must be selected in the Device List.   
 

 
 
Non-DMX traffic between PM5 and the chosen node will be shown.  When there are no 
problems, about every six seconds PM5 will receive an ARP from the node.  PM5 will 
then send a ‘Get Properties” request, which the node will answer. 
 
If there are communication problems between PM5 and the node, they will be reported 
here, in various ways, dependent on what the problem is.  
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Appendix A – Device Property Definitions 
The properties of devices compliant with Pathport standards are displayed in the main 
Device List screen.  The list can be customized by right-clicking and choosing ‘Select 
Columns to Display’.  Clicking on the ‘Visible’ check box will either show or hide the 
property in the main display.  These customized views can be saved – see Customizing 
Display Views above.   
 
Properties are not editable from the “Select Columns Shown” list, only the main screen. 
 

Device Property Definitions 
 

Name Definition 
Config Ch Indicates uncommitted changes in the Node Properties tab 
Patch Ch Indicates uncommitted changes in the DMX Patch tab 
Showfile Displays name of current showfile (if any) 
Online Indicates if device is detected online 
Status Indicates if device can be communicated with 
ARPS Received Sequential “heartbeat” packet counter 
ARP Update Time stamp of last heartbeat received 
GET Update Time stamp of last successful GET  
Name User-defined device name (returns ‘blank’ if empty) 
IP Address IP address returned by the device 
Manufacturer Name of manufacturer 
Device Class Class of device reporting (if defined) 
Device Type Product name of reporting device (if defined) 
Base? Future development  
Id Pathport Protocol device packet unique identifier 

# Ports Number of DMX ports 
Latest Action Shows success/failure of last property update to node 

 
  
 

Appendix B – Base Node and Port Property Definition s 
The base node and individual port properties are displayed in the Device Properities 
screen.  The list can be customized by right-clicking and choosing “Select Properties to 
Display”.  Selecting the “Visible” checkbox will either show or hide the property in the 
main view.  These customized views can be saved – see Customizing Display Views 
above.   
 
Note:  The default list of properties is sufficient for the large majority of users.  Some 
properties, when set incorrectly, will cause the system to stop functioning. 
 
Properties are not editable from the “Select Properties Shown” list, only the main screen. 
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Base Node Property Definitions 

 
Name Definition 

Name Node name – user assignable 
MAC Address Media Access Control address – factory assigned 
IP Address Internet Protocol (IPv4) Address – editable 
IP Subnet Mask IP subnet mask – editable 
IP Default Gateway IP address of system router – not typically used 
Firmware Version Current operating firmware number 
Identify Node Enabling causes node to flash screen or LEDS 
Node Serial Number Factory-assigned serial number 
Enable Keypad Lockout Enable/Disable any front panel keys 
Enable LCD Backlight Turns LCD screen backlight on or off 
LED Intensity Uno only.  Toggles between Bright and Dim 

Universe Select Lockout Jumper  
Uno and eDIN only.  Reports if universe jumper is set, 
and to what universe (1-4) 

Enable IrDA Port Feature no longer supported in firmware 

Receive Artnet Enable/disable Artnet 
Receive E1.31 Streaming ACN Enable/disable sACN 
Receive ETC Net2 Enable/disable ETC Net2 (one- and two-ports only) 
Receive Pathport Protocol Enable/disable Pathport 
Receive Shownet Enable/disable Shownet 

Transmit Network Protocol 
Select input protocol from drop down.  Choices are 
Artnet, Pathport, Shownet and streaming ACN. 

ArtNet Alternate Mapping 
Toggle between Artnet universe 0-0 shown as Univ 1 or 
ignore Artnet universe 0-0 altogether 

E1.31 Transmit Version Toggle between Draft 20 and ANSI Final Release 

sACN Input Priority 
Toggle between ignore sACN input priority schemes or 
accepting sACN input priority (disables other protocols) 

Has Terminal Blocks Informational 

Is Rack Mounted Informational 
ETCNet2 Admin Multicast 
Address 

Future use 

ETCNet2 EDMX Multicast 
Address 

Future use 

Bootp Deselect for static IP.  Select to seek for Bootp server 

Bootp Timeout (seconds) 
# of seconds a node seeks for Bootp server before 
completing boot up with last used IP address 

Force Dynamic IP 
Forces node to wait for IP address from DHCP or Bootp 
server.  Node will hang if no server present.  Not 
recommended for most installations 

Do TFTP Upgrade 

Forces node to wait for IP address from DHCP or Bootp 
server, then request firmware file during boot up.  Node 
will hang if no server present, or server doesn’t have 
firmware file.  Not recommended for most installations. 

 
Note:  Pathport Manager 5 does not provide a Bootp or DHCP server. 
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Port Property Definitions 
 

Name Definition 
Port Name User-assigned port name – by default “Port x” 
Port Direction Toggle input/output, regardless of connector gender 
DMX Status Informational – Active when port sees DMX activity 
Patch Name Output patch name (does not apply to input ports) 
DMX Port Enable Toggle enable/disable port 
DMX Output Speed  Slow (31Hz), Med (36Hz), Fast (40Hz) or Max (44Hz) 
E1.210 RDM Enable Toggle enable/disable Remote Device Management 

Quick Patch Enable 
Allows backward compatibility with older firmware.  Will 
override source patching.  Disabling is recommended 

Quick Patch Universe Sets Quick Universe number, if enabled 
xDMX Status Indicates presence of Pathport Protocol 

xDMX Source Universe 
Sets source patch universe – applies to inputs only 
Not recommended as method of patching 

E1.31 sACN Input Priority Level Value between 1 (low) and 200 (high).  Default = 100 
E1.31 sACN Input Priority 
Channel 

Sets ‘magic channel’ for on-the-fly source selection when 
using sACN. Range= 0-512. Default = 0 (disabled) 

Crossfade enable Allows crossfade between inputs on signal loss/gain 
Crossfade time (ms) Sets crossfade time 
Signal Loss Hold Time (ms) Sets time to hold last look on loss of input signal 
Signal Loss Hold Forever Holds last look forever on loss of input signal 
Signal Loss Fade Allows fade to zero when Hold Time expires 

Signal Loss Fade Time (ms) Sets time to fade to zero if Fade enabled 

Signal Port Shutdown If enabled, port stops sending DMX packets when fade 
reaches zero.  Will resume when signal restored 

Bidirectional Redundant - all ports are bidirectional 

Gender Reports gender of XLR connectors.   

Physical Reports if port actually exists 

Terminated DMX Manager Plus only.  Reports if termination resistor 
is enabled or not. 
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Appendix C –  Network Interface Card (NIC) Configur ation  
For Windows XP: 

Control Panel>Network Connections>Local Area Connection>Properties 
button>highlight Internet Protocol (TCP/IP) from list>Properties button (again).   

Select “Use following IP address” radio button.  Enter the desired IP and subnet 
mask.  Set Default Gateway, if required (typically it isn’t).  Click “Close/OK/Accept” until 
you’ve backed all the way out of the menus.   

You do not need to reboot the computer. 
If you have more than one NIC (for example, if you have a wireless card), choose 

the correct one at Local Area Connection. 
 
For Windows Vista: 
 Control Panel>Network and Internet>Network and Sharing Center>View network 
status and tasks.  The left-hand column is called Tasks.  Select Manager Network 
Connections.  Choose Local Area Connection>Properties.  Answer the User Account 
Control prompt.  Highlight Internet Protocol Version 4 (TCP/IPv4)>Properties (again).  

 Select “Use the following IP address” radio button.  Enter the desired IP 
and subnet mask.  Set Default Gateway, if required (typically it isn’t).  Click 
“Close/OK/Accept” until you’ve backed all the way out of the menus.   
 
For Mac OS 10.5: 
 System Preferences>Network (from Internet&Network).  Configure=’manually’.  
Set IP address, Subnet Mask and Router(= default gateway) as required.  Click Apply.  
Make sure these settings are not locked before attempting the changes. 
 

Appendix D - Common IP Address Schemes 
The following are some default industry IP addressing schemes: 
 
Pathway Connectivity (Pathports) 
 IP range:    10.x.x.x 
 Subnet mask:  255.0.0.0 

Pathports can be set to any valid IP 
address and subnet mask 

 
ETC 
 IP range:  10.x.x.x 
 Subnet mask:  255.255.0.0 

Some ETC equipment is hard-coded 
to specific IP addresses 

 
Strand 
 IP range:  192.168.0.x 
 Subnet mask:  255.255.255.0 

Strand nodes are shipped with an IP 
of 192.168.0.1.  This subnet mask 
allows for only 254 devices 

 
Artistic Licence (ArtNet devices) 
 IP range  2.x.x.x 
 Subnet mask:  255.0.0.0 
 

This IP is a potentially routable 
address and should not be 
connected to the Internet without 
precautions 

 


